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1. Introduction 
QC-PLC is a combination Windows application/service that provides a fast and 
easy method of reading data from programmable logic controllers (PLCs) for data 
collection in QC-CALC Real-Time. It has been written to work with roughly 90-
95% of Ethernet connected PLCs on the market. QC-PLC is a client application 
that typically resides on a central server at each plant and is responsible for 
reading data from the registers of your PLCs at regular intervals. The data is 
organized into specification plans (or spec plans) with nominals and tolerances 
much like QC-Gage. QC-Gage is a separate windows program used to read data 
from hand gages. The main difference between QC-PLC and QC-Gage is that in 
QC-PLC the data is read automatically on a timed schedule or based on an event 
such as the value of a register changing. The results are then sent to QC-CALC 
Real-Time for data collection.  

1.1  What is the Data Source 
Currently, the sources of inspection data are the programmable logic controllers 
(PLCs) on your shop floor. 

1.2  What If I Don’t Have a Network 
A network is typically required to successfully run QC-PLC in your plant. The only 
other option would be to put both QC-PLC and QC-CALC Real-Time on the 
same PC. 

2. Setup 
QC-PLC is distributed via the Internet and must be installed in your Windows PC 
or server using a standard SETUP.EXE style program. Perform the following 
steps: 
 

1. Install QC-PLC on the computer that will do the data collection by double 
clicking the setup executable and following the wizard prompts. If you 
simply accept the default settings, it will set itself up normally. 

 
2. Install QC-CALC Real-Time on the same PC following its installation 

wizard. Again, taking the defaults is recommended.  
 

3. You are now ready to begin using QC-PLC. 

2.1  How Do I Get a Copy of QC-PLC/QC-CALC 
If you do not own copies of QC-PLC and/or QC-CALC you can download both for 
free and try them for 30-days. Visit the Downloads page of our website at 
www.ProlinkSoftware.com/download.  
 
If you have a Prolink account you must login to download. If you do not have an 
account, you can create one instantly by entering some basic information about 
yourself including an email address and password.  

3. The Basics 
Before getting into the details about this software product, let’s quickly cover the 
basics. Double click the QC-PLC icon on your desktop to start the QC-PLC 
Client. 
 

http://www.prolinksoftware.com/download
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On first launch the main screen is opened for you so you can see Currently 
Loaded Spec Plans and the Activity Log. When you first run QC-PLC, you 
won’t have any spec plans loaded so the main grid will be empty.  

3.1  The Main Screen Layout 
The main screen uses a ribbon style layout that is based on the ribbon control in 
Microsoft Office 2010. If you are familiar with Office, then this interface should be 
easy to learn. 

 
At the top are two tabs; File and Home. The File tab opens a list of options that 
help you license, troubleshoot, and update the application. See File  on page 22 
for details. The Home tab contains all the most commonly used functionality of 
the application broken into logical groupings of buttons. The button groups are: 

Spec Plans 
Allows you to add, edit and delete spec plans. In addition, the Load Plan button 
allows you to activate an existing spec plan to begin collecting data. By default, 
spec plans are not loaded. This allows you to control which plans will collect data 
at any given time. See Setting Up Your First Spec Plan on page 10 for details. 

PLC Connections 
Allows you to add, edit, and delete connections to your PLCs. In addition, the 
large Test Connection button allows you to quickly test a connection (connect to 
the actual PLC to see if it is online). See Connecting To Your PLCs on page 3 for 
details. 

Preferences 
This area is used to control the settings of the QC-PLC tool. Buttons include 
Pause Data (to pause data collection entirely), Settings which opens the 
Preferences screen (page 18), and Exit which exits the application. 

3.2  Licensing QC-PLC 
QC-PLC typically comes with the ability to connect up to 10 PLCs of one type 
without the need for further licensing. If you need to collect data from more than 
10 PLCs and/or have different types of PLCs (i.e. Allen Bradley and Siemens), 
please purchase the correct number of licenses and libraries to suit your 
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individual needs. If you have questions about this, please contact Prolink for 
assistance and quoting. 

3.3  Connecting To Your PLCs 
The first thing you need to do to begin collecting data is to 
connect to your PLCs. Even though data is collected through 
spec plans, you first must create a re-usable set of 
connections so your spec plans can use them when 
retrieving data from your PLCs. This way, you can have 
multiple spec plans collecting data from the same PLC   
without having to reconnect each time. In addition, your spec plans can collect 
data from multiple PLCs simultaneously so this allows for greater data collection 
flexibility. 
 
To create a new connection, 
click the Add New button in 
the PLC Connections 
grouping on the ribbon 
control. A screen like the one 
to the right appears. 
 
At the top of the screen, 
name your connection 
something familiar that you 
will remember later and 
choose the type of PLC from 
the PLC Type list. Since 
each type of PLC has 
different settings, the next 
few sections will detail the 
individual screens and 
settings you will see based 
on the type of PLC you 
choose. 

 

3.3.1 Allen Bradley CompactLogix/ControlLogix 
The Allen Bradley CompactLogix/ControlLogix interface is fairly straightforward. 
Simply enter the IP address of the PLC and the CPU Slot/CIP Path.  
 
The CPU Slot is often 0 or 1; you may want to try that as a default. To test your 
connection, click the Test Connection button. QC-PLC will attempt to contact 
the PLC and will display a message telling you whether or not it was successful. 
If not successful, make sure your settings are correct and that your PLC is online 
before proceeding. Otherwise, your spec plans cannot collect data. 

3.3.2 Supported PLCs 
ControlLogix 

1756-L55M12 
1756-L55M22 
1756-L625 
1756-L55M13 
1756-L55M24 

 
1756-L61 
1756-L64 
1756-L55M15 
1756-L615 
1756-LM60M03SEv 

CompactLogix 
1769-L23 
1769-L32 
1769-L35 
1768-L43 
1768-L45 
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1756-L63 
1756-L55M14 

1756-L55M16 
1756-L62 

SoftLogix 
5800 

 

3.3.3 Allen Bradley MicroLogix/PLC-5 
The Allen Bradley 
MicroLogix interface has 
a couple settings based 
on the settings of your 
individual PLC. Simply 
enter the IP address of 
the PLC and then specify 
the Ethernet and 
Controller options. The 
most common options 
are specified in the 
picture below. You can 
try different combinations 
if you have troubles 
connecting with the 
defaults. 

 
 

3.3.4 Supported PLCs 
MicroLogix 1100 & 1400 

1763-L16 (all series) 
1766-L32 (all series) 

MicroLogix 1000, 1200, & 1500 
1761-L10 
1761-L161 
1761-L32 (all series) 
1762-L24 
1762-L40 (all series) 
1764-24 
1764-L28 (all series) 

SLC-5/05 
1747-L551 
1747-L552 
1747-L5532 

SLC-5/04 
1747-L541 
1747-L542 
1747-L543 

 

SLC-5/03 
1747-L531 
1747-L532 
1747-L 

PLC-5/11 
1785-L11B 

PLC-5/20, 5/20E, & 5/20C 
1785-L20B 
1785-L20E 
1785-L20C15 

PLC-5/26 
1785-L26B 

PLC-5/30 
1785-L30B 

PLC-5/40, 5/40E, 5/40L, & 5/40C 
1785-L40B 
1785-L40E 
1785-L40L 
1785-L40C15 
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GE Fanuc PLCs 
The GE Fanuc interface is the simplest of all. Simply enter the IP Address of the 
PLC and it will connect. Click Test Connection to test the connection. 

 

3.3.5 Supported PLCs 
PACSystem RX3I 

PACSystem RX7I 

Versamax Micro, Nano and Modular PLC's 

Series 90-30 311, 313, 331, 341, 350, 360 or higher 

Series 90-70 731, 732m 771, 772, 781, 782 or higher 

Horner OCS (Operator Control Stations) 
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3.3.6 Modbus PLCs 
The Modbus interface supports Ethernet, Serial and Serial over Ethernet devices. 
For Ethernet, simply enter the IP Address of the PLC and the port number. The 
port number is most commonly set to 502, but can be set to whatever you 
choose. 
 
If your Modbus PLC is set to serial, you must fill out the Serial Setup area 
including the Serial/COM port, baud rate, data bits, parity, and stop bits. Your 
Modbus manual should have this information. 

 

3.3.7 Supported PLCs 
All Modbus PLCs 
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3.3.8 Siemens PLCs 
The Siemens PLCs vary slightly based on version, but will look like the picture 
below. Enter the IP Address and then either the TSAP Local/Remote values 
(S7200 series only) or the Rack and CPU Slot values (S7300, S7400, S71200 
series). 

 

3.3.9 Supported PLCs 
Siemens S7-200 via CP243 

Siemens S7-300 via CP343 

Siemens ET 200 via built in Ethernet ports 

Siemens S7-400 via CP443 

Siemens S7-1200 via built in Ethernet module 
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3.4  Testing Your Connection 
There are multiple ways to test the connections to your PLCs. During the 
connection creation process above, most of the PLC types allow you to do a 
quick test of the connection to make sure your IP address and settings will allow 
a valid connection. In those cases, the results will be displayed in a special area 
on the screen. 
 
However, there is a more comprehensive test that can be run that actually allows 
you to check the values of particular registers on the PLC. To run this test, select 
the Test button in the Connections group on the main ribbon bar. The following 
screen appears. 

 
From this screen, you have a couple options. First, you can simply check the 
connection by choosing the connection from the drop down list, leaving the other 
fields blank, and selecting Run Test. The screen will only attempt the connection 
and return the results in the box below. 
 
You can also check individual register values by typing an address into the Test 
Address box. If you know the data type, choose it from the list. Otherwise, leave 
the setting as “—Try them all—“ and QC-PLC will attempt each data type in 
succession. The results will be displayed below. 
 
This can be a convenient way of checking the data type if you do not know how 
the value is being stored in the PLC. As you can see in the picture above, a 
floating point decimal address (F8:0) was entered for an Allen Bradley Micrologix 
PLC. QC-PLC then tried each data type. Some of them returned errors saying 
they were able to return a value, but that it wasn’t a valid integer (whole number). 
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Toward the bottom of the list, it tried the Floating Decimal and successfully 
returned 0.8448964. It was also able to convert this value to a valid string of text. 

3.5  Why Data Types? 
You may notice throughout the screens whenever there is a connection and PLC 
address, there is also a data type list that you must specify. This is in place 
because PLCs store different types of numbers and flags in different sized 
memory locations. If you just specify the address without the data type, QC-PLC 
knows where to start pulling the data, but not how much data to pull back. As 
such, we must specify the data type so the PLC knows how much data to send 
back and load into the value.  
 
There are certain exceptions to this rule based on the type of PLC. In these 
cases (such as certain Allen Bradley PLCs), the data tables are declared in the 
PLC to be of a certain type (integer, decimal, string, flag, etc). In these cases, the 
data type on the screens is ignored since the address of the register already 
contains the definition of the data type. Since QC-PLC must cover all cases, 
however, we add the fields and require them to be filled out. 
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4. Setting Up Your First Spec Plan 
Once you have successfully connected to your PLC(s), it is time to create the 
Specification Plans (Spec Plans) that will actually do the data collection. Spec 
plans have been modeled after the spec plans in QC-Gage to help speed the 
learning process. The concept is that you can create as many spec plans as you 
desire. Only those spec plans that are activated are actually collecting data. This 
gives you the flexibility to activate different sets of spec plans at different times or 
from different PCs according to your preference. A spec plan is simply a set of 
measurements and factors (trace fields) representing a part or the process at a 
point in time. These measurements are gathered from one or more PLCs on 
some schedule and are sent to QC-CALC Real-Time for data collection. The 
schedule can either be time based (i.e. every 2 minutes) or event based (i.e. 
whenever register 12’s value changes to 1). 
 
To create a new spec plan, click the Add New button in 
the Spec Plans grouping on the main ribbon bar. A 
wizard like the one below will appear. 
 

4.1  Welcome Screen 
 

The Welcome screen allows you to name your spec plan. The name of the spec 
plan will automatically become the name of the QCC file created in QC-CALC 
Real-Time. Select Next >> to continue. 

 
If you click the Show Advanced link just below the Spec Plan Name, three more 
fields will appear that allow you to change the way QC-CALC behaves during 
data collection.  

Override QC-CALC Database Name 
If you choose, you can override the name QC-CALC will use for its QCC file. If 
specified, QC-CALC will use the overridden name as the name for the QCC file 
rather than the name of the spec plan. This allows you to have multiple spec 
plans sending data to the same QCC file via the multisource feature in QC-
CALC. 

Override QC-CALC Database Path 
Much like the QC-CALC PATHSWITCH feature that works with some CMM 
software, this allows you to override the path to which QC-CALC saves the QCC 
file. NOTE: This will only work if you have allowed the path to be passed from the 
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machine in the Tools – Options – Data Collection – Data Source Information 
section of QC-CALC Real-Time. 

Override Spec Plan Path 
This will override where the spec plan is actually stored. By default, spec plans 
are stored in the spec plan path in the Settings area.  

4.2  Factors Screen 
This screen allows you to set up factors (trace fields) for your spec plan. You can 
add up to 30 numeric and 30 text factors per spec plan and each can point to its 
own register address on any PLC.  

 
As with most Prolink products, you create, edit and delete factors with the plus, 
pencil, and “x” buttons above the list. You can also double click on items in the 
list to edit them. 
 
When adding or editing factors, you will see the Factor Setup screen. This 
allows you to specify a name, choose the type, PLC connection and PLC 
address. In addition, you should specify the data type since certain PLC types 
require this. Please keep in mind that because each factor has its own 
connection setting which means that different factors in your spec plan can come 
from different PLCs. The Test Address link allows you to test the address via the 
Connection Testing screen. Please see the section above on testing a 
connection and address. 
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4.3  Features Screen 
Like the factors screen, you maintain the list of features you will be collecting on 
this screen. The list includes the usual add, edit and delete buttons, but also 
includes a copy button and up/down arrows on the right side of the list for 
reordering features. 

 
When you add/edit features, you will use the Feature Setup screen. On this 
screen, the feature label, tolerance type, connection, actual (address) and data 
type are required. For Nominal, Plus Tolerance, and Minus Tolerance, you can 
either specify a decimal number or an address on the PLC from which the 
nominal or tolerance should be retrieved.  
 
If you choose to use the nominals from registers on the PLC, specify the 
address, check the Use Address checkbox, and choose the Data Type. 
Typically, the numbers are floating point decimals and are loaded into QC-CALC 
Real-Time as such. 
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4.4  Schedule Screen 
The schedule screen tells QC-PLC how often the spec plan should collect data 
from the PLC. There are currently two types of schedules; interval (or time) 
based and event based. 

 

Interval Based 
This is a fairly simple timer. You simply type a number and choose seconds, 
minutes, or hours. Whenever the interval has passed, QC-PLC will attempt to 
collect all data for the spec plan from the PLC. 

Event Based 
With this type of schedule, you specify a connection, the address of a PLC 
register, and the data type of the value coming from the register. QC-PLC will 
then watch the register for a change to the value of the register and trigger the 
data collection when that event occurs. You can check either that the value 
“changes to” a particular value you specify or that it “changes” at all. 

 
In the case of a “changes to” situation, it will only trigger once whenever the 
value changes to the desired value. For instance, let’s say you have a register 
with a value of 0 and you want to collect data when the value changes to 1 
(typical flag scenario). When the value changes to 1, QC-PLC will collect the data 
once and will then wait until the value changes to something else before resetting 
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the trigger. QC-PLC never changes the values of registers on your PLC. This is 
something you should do in your ladder logic. 
 
The trigger for “changes” is similar to the “changes to” trigger except that the 
trigger will happen whenever the value changes regardless of what the new 
value is (but only once per change). Therefore, using the example above with 0 
and 1, QC-PLC will trigger when the value changes from 0 to 1. It will then trigger 
again when you set the value back to 0.  

4.5  Finish 
This is a typical Finish wizard screen. To save your spec plan, select Finish. To 
cancel all changes, select Cancel. If you would like to activate the spec plan 
immediately, check the Activate Spec Plan Now option before selecting Finish.  
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5. Live Monitoring Screens 
In addition to data collection, you can choose to put live monitors on your main 
screen that monitors the addresses of the PLCs. The addresses to monitor are 
specified by specifying a spec plan to use. Each feature in the spec plan is then 
displayed as either a radial gauge or continuous line chart.  
 
NOTE: You can monitor any spec plan and not just those are currently active 
(collecting data). Indeed it may make sense to create certain spec plans for the 
sole purpose of monitoring without any intention of using the spec plans for data 
collection. In the case of monitoring the spec plan merely provides a framework 
to monitor features. The upper and lower tolerance values provide scaling 
(min/max values) for the monitoring charts. 

5.1  Setting Up Monitoring 
The main screen is actually a tabbed interface (just below the ribbon bar). To 
create a monitoring screen, click the plus (+) sign just to the right of the Current 
Status tab. To close a monitoring screen, click the “X” at the far right of the tab. 
You can close all tabs except the Current Status tab. This tab is always present. 

 
Once the new tab has been created, you will see a bar that can be pulled down. 
Simply move your mouse pointer over the bar and it will pull down revealing the 
settings for the monitoring screen. The monitoring screen has two settings; the 
spec plan to monitor and the frequency to update the screen. You can either 
choose a spec plan from the list by selecting the Choose button or navigate to a 
spec plan at a particular path by selecting the “…” button. 

5.2  Changing Graph Type 
When you set up the monitoring screen, radial gauges (resembling 
speedometers) will appear for each feature in the spec plan chosen. The range 
of data (upper and lower limit) is taken from the upper and lower specs from the 
features of your spec plan and the meters will refresh at the frequency specified.  
 
If you wish, you can change individual features to a continuous line chart by right 
clicking on any feature and choosing Show As Line Graph. This will change the 
chart to a line graph that holds the last 25 points. 
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All monitoring pages that are on screen are automatically remembered when you 
close and re-launch QC-PLC. 
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6. PLCDataService 
QC-PLC will work normally out of the box and you can begin collecting data 
immediately. However, you will soon notice that you cannot collect data from 
your PLCs if you close the application or when the PC is not logged in as a user. 
This is because by default, QC-PLC runs as an application. However, QC-PLC 
can also run as a Windows Service and can be changed at any time. When 
running as a service, it means that QC-PLC will continue to run as long as the 
PC/Server is powered on even if nobody is logged in. This makes it convenient 
for IT deployments since IT departments don’t typically leave servers logged in 
permanently.  
 
QC-PLC is defaulted to run as a Windows application so you can collect data 
immediately without the complication of setting up a Windows Service on first 
run. In the longer term, it is recommended that you run it as a service in order to 
ensure data is always collected as expected. Switching the program over to a 
service is fairly easy and requires only a few clicks. Before doing so, please 
familiarize yourself with Appendix B: A Word about Windows Services so you 
understand how services operate in the Windows environment.  
 
Switching QC-PLC to run as a service requires two steps; flipping the flag to run 
as a service and turning on the service itself. First select the Settings button on 
the main ribbon control. Then click Service Settings in the list to the left of the 
Preferences screen. 

 
Choose Run QC-PLC as a service and click Start Service. Click OK to save 
your changes. To run QC-PLC as an application, return to this screen, choose 
Run QC-PLC as an application and click OK. 
 
Once QC-PLC is running as a service, your spec plans will continue to run even 
if you close the main QC-PLC window. As such, you can simply close the 
application once you have set up your spec plans. This is because the service is 
a separate application running in the background. The QC-PLC client can run 
either in the Windows system tray (lower right corner of screen near the clock) or 
be shut down once events are scheduled and options chosen. 
 
NOTE: Please see Appendix A – A Word about Windows Services for 
considerations when running QC-PLC as a Windows Service on page 26. 
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7. Setting your Preferences 
7.1  Preferences 

The Preferences screen with all the options described below 
is available by choosing Settings in the File tab or by clicking 
the Settings button in the Preferences area of the Home 
tab. 
 

7.1.1 General  
The General screen has all the general non-categorized settings listed here: 

 

Language  
This identifies the current language being used by QC-PLC for all screens, 
messages, labels, buttons, etc. in the application. NOTE: Debug and Error 
messages are always in English to help with troubleshooting by Prolink. 

Application Theme 
This is a visual preference that allows you to use one of a few different themes 
throughout the application. The default setting for this is Office 2010 Blue. If you 
change this setting you must restart QC-PLC in order for the new theme to take 
effect. 

Main Timer Interval 
This setting tells QC-PLC how often it should check to run active spec plans and 
refresh the monitoring screens. The units for this setting are milliseconds so 1000 
= 1 second. For the most part, you should leave this set to 1000 (or 1 second). 
This way QC-PLC will check each second whether or not it should run your 
active spec plans. However, should you want to run it more often, you can 
decrease this time to a fraction of a second or as high as 10000 (10 seconds). 

Debug Mode 
If checked, a file is generated called debug.log in the directory where QC-PLC is 
installed. This log contains detailed information on each activity done by QC-
PLC. Generally, you should keep this setting unchecked for performance 
reasons. However it may help with troubleshooting if you are having troubles and 
need to see what is happening.  
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WARNING: This file will get extremely large if this option is checked for long 
periods of time since QC-PLC is literally logging everything it is doing.  

Minimize To Tray 
This option changes the behavior of the Minimize button in the top right corner of 
the window. If checked, the QC-PLC client will minimize itself to the tray of your 
desktop rather than just the task bar. When minimized to the tray, you can 
restore it by either right clicking the icon and choosing Restore or double clicking 
the icon. 

7.1.2 Set Paths 
This screen allows you to set the paths that are relevant to the operation of QC-
PLC. To set the file locations, simply enter the path by typing or browse to the 
folders and file on your local PC or network.  

 
Spec Plan Path 

This is the path where all spec plans are stored. These are all separate files that 
can either be shared on a network or copied from PC to PC. Spec plans have a 
.plc extension unlike the equivalent spec plans in QC-Gage that have a .spl 
extension. This was done to prevent confusion. 

Output Path 
This is the path where QC-PLC will write its output data for QC-CALC. QC-PLC 
has been set up to act like any other automatic inspection machine/QC-Gage in 
that it writes a data file each time it runs an inspection. QC-CALC should be set 
to read this same folder on your PC. 

Connections Path 
In QC-PLC all the connections to the PLCs themselves are stored separately 
from the spec plans to allow you to re-use common connections across the spec 
plans. This path is where the list of connections is stored. 

7.1.3 Email Settings 
This screen is used to configure your outbound SMTP server for sending email. 
SMTP (or Simple Mail Transfer Protocol) is required in order for any application 
to send mail via the internet. The application (in this case QC-PLC) 
communicates with the SMTP server that resides on either your internal network 
or the internet and has the ability to route email. This is unrelated to and runs 
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independent of any other email clients such as Lotus Notes or Microsoft Outlook. 
In fact, those email clients also must communicate with an SMTP server in order 
to send their mail. 
 
By default, QC-PLC is set up to Use Prolink default server settings located on 
the Internet. This way, the email option works out of the box. However, it is 
recommended that you enter your company’s actual SMTP server information as 
it will keep the traffic lower on Prolink’s servers and increase performance 
(decrease the time it takes for you to receive an email from QC-PLC). In addition, 
you may not be able to use Prolink’s servers if your IT department blocks SMTP 
transmissions to servers outside your network (firewall). If this is the case then 
your IT department should be able to help you set up this screen. 

 
The fields are as follows: 

Sender Name 
The name that appears in the FROM box of emails you receive from QC-PLC. 
This can be anything you choose and should be something recognizable. 

Sender Email 
This is the email address that appears in the FROM box of emails you receive 
from QC-PLC. Due to security reasons, the domain portion of the email 
(everything after the @ symbol) should match the domain on your server. 
Otherwise, you will not be able to send emails. Notice how we are using the 
Prolink servers in the picture above and the sender email is from 
ploutbound@prolinksoftware.com.  

SMTP Server 
This is the server through which email will be sent. Your IT department can help 
you with this setting. 

SMTP Port 
This is almost always set to 25, but your IT department may have specific 
settings to use. 

mailto:ploutbound@prolinksoftware.com
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User Name 
This is the account name that QC-PLC will use to send the email. If your SMTP 
server allows anonymous email sending, enter the word “test”. Your User Name 
is displayed as zeros. 

Password 
This is the password for the account that QC-PLC will use to send the email. If 
your SMTP server allows anonymous email sending, enter the word “test”. Your 
password is masked as asterisks. 

7.1.4 Notifications 
Since QC-PLC has been designed to run unattended, there are no error 
messages that pop up on the screen when it is running on the timer. Therefore, 
in order to know that an error has occurred, you may want to have QC-PLC email 
you the error so you can take appropriate action to fix it. This screen allows you 
to do just that. To enable the functionality simply check the Email 
Administrators On Error box and enter as many email addresses (or 
distribution lists) as desired separated by semi-colons (;). You can also choose to 
Email Administrators on Success if you would like to know when QC-PLC 
successfully collects data. 

 
If you would like to generate a test email to make sure the email settings are 
correct, simply click the Test Email button. You should receive an email within a 
minute or two confirming the email settings are valid. 
 
NOTE: If you have not set up the email settings (last section) you may not 
receive emails just yet. Make sure the SMTP settings are set and saved before 
testing the email. This means setting the SMTP settings, clicking OK to save the 
settings, and then going back into Settings to test the email. 

7.1.5 Service Settings 
Please see PLCDataService on page 17 for details on setting up QC-PLC to run 
as a service. 
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8. File Tab 
8.1  Pause Data Collection  

This option pauses and restarts data collection. This is the 
same as the Pause Data button in the main ribbon bar. 
 

8.2  About  

This screen gives you information about the version of QC-PLC. There are two 
main buttons on the screen; Run Update and Gather Information. 
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8.2.1 Run Update  
This choice launches the update screen that will attempt to update your software 
to the latest version. To start the update, click the Start Update button. If a 
newer revision of the software is available, it will automatically download and 
install over your existing version. None of your settings are lost. Only the 
software itself will be replaced. You can cancel at any point during the download. 

 

8.2.2 Gather Info 
This button launches the form that you can use to gather information for Prolink. 
Under certain circumstances, Prolink personnel may ask you to run this 
command in order to troubleshoot your installation. The gather information file 
will gather all the local settings for QC-PLC, create a zip file, and email the file to 
Prolink for troubleshooting. 
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8.3  License Config 

8.3.1 Description 
This area of the application is used in conjunction with the Prolink website to 
activate QC-PLC. It shows your overall license status, Prolink Serial Number 
(PSN), Computer ID, number of licensed connections, and the PLC libraries that 
you have licensed. This screen is where you validate new licenses and kill 
existing licenses (for the purpose of transferring your license to a different PC). 

 

8.3.2 Obtaining a License from Prolink 
From the My Account area of the website, click the Activate link for the copy of 
QC-PLC you want to unlock and follow the directions for generating an activation 
code. You will need to enter the Computer ID shown in the License Configuration 
screen (pictured above). Clicking Get Activation Code will generate a 25 digit 
activation code that can be used to activate QC-PLC permanently. 

8.3.3 Activating QC-PLC 
Enter the activation code generated on the Prolink website in the Activation 
Code area of this screen and click the Validate button. If the code is valid, you 
will get a message stating that you have activated your software. The PLC 
libraries you have purchased will show green checkmarks beside them and the 
number of Licensed Connections will show in the box above. 
 
Prolink licenses the number of available connections in groupings of 10. All 
copies of QC-PLC come with 10 simultaneous PLC connections by default. 
Please see your Prolink sales agent if you need more than the allotted amount. 

8.3.4 Kill License 
The Kill License button deletes the current license for QC-PLC. As mentioned 
above, this is typically used for transferring licenses between two computers. If 
this is done by mistake another Activation Code for the same computer can be 
generated by using the Details link listed for this copy of QC-PLC on the My 
Account page of the Prolink website. 
 
If the Computer ID listed on the website does not match what is shown in the 
Activate Software screen you need to contact Prolink. 
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8.4  Settings 
This area is used to control the settings of the QC-PLC tool. See Preferences on 
page 18 for more details. 
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9. Appendix A 
9.1  A Word about Windows Services 

Windows services are a useful way to ensure your programs stay running even if 
the user doesn’t stay logged into the workstation. Unlike normal Windows 
applications, services stay running on the computer even when the current user 
has logged off. This ensures that QC-PLC continues to load the data on schedule 
even if nobody is currently logged into the PC. However, with this benefit come a 
few considerations. Below is a list of items to consider when deploying QC-PLC. 

9.1.1 QC-PLC Client vs. PLCDataService 
Since Windows services do not have screens, we split QC-PLC into separate 
pieces; the QC-PLC Client and the PLCDataService. The client is the application 
that appears when you run QC-PLC, change settings, create events, etc. The 
PLC Data Service is a silent application that runs in the background.  

 
You can see the PLC Data Service running either by going to Tools > Options > 
Service Settings or by visiting the Services area in Windows. This is under Start 
> Control Panel > Administrative Tools > Services. 

 
 
If you right click on the PLCDataService 
service, choose Properties, and the 
screen shown to the right appears. From 
this screen you can see the path where 
the executable actually exists and you 
can control the starting and stopping of 
the service. 
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9.1.1 Login Permissions 
Remember that the service is running 
regardless of whether or not you are 
logged into the workstation. As such, it 
must have its own login settings in order 
to run and access files on the network. 
When you set up the security for the 
service, you’re basically telling it to access 
the network as “xyz” user account. 
Whatever xyz has access to read, write, 
and delete, so does the service since it 
will log into the network as xyz. Typically 
you will want your IT department to create 
an “application” type user account on your 
domain. The difference between an 
application type account and a standard 
user account is that the application 
account doesn’t usually follow all of the 
same rules. 

 
For instance, it wouldn’t make sense to have an expiring password since the 
service isn’t going to be aware enough to change its password every 60 days. 
 
Make sure the user account you have IT create has read, write and delete 
privileges to folders on the network where settings or other files exist. Once your 
IT department has given you a user id and password, switch to the Log On tab, 
choose This account, and enter the user id and password. 
 
NOTE: You will need to stop and start the service after applying this in order for 
the changes to take effect. 
 
NOTE: You can type your own login user account and password for testing 
purposes if necessary and it will work without problems. However, it is not 
recommended beyond testing because you will eventually change your 
password, forget to update it here, and the PLC Data Service will no longer have 
access to the network. 
 
By default, you’ll notice that the Log On is set to “Local System Account”. This is 
a special user account in Windows that should work out of the box. However, in 
many cases it will not work because your IT department’s security policy 
removes access. This is done for security reasons so viruses do not use your PC 
for unintended purposes. 

9.1.2 Mapped Paths/Drive Letters Illegal for Services 
Unfortunately, using mapped paths does not work for services. This is because 
mapped drive letters (such as your “N” drive) are user specific. This means your 
N drive could be different from someone else’s N drive. To simplify this, Microsoft 
has stated that services must use Unified Naming Convention (UNC) paths. 
 
The UNC format will get you to the same place, but uses the server and shared 
directory directly rather than mapping it to a drive letter. The format is 
\\servername\shared folder\folder\folder. 
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Using the example in the picture on the right, notice 
the H drive that is mapped in Windows Explorer. The 
actual path to which the H drive is mapped is 
\\ntserver\d-drive. You can see this is defined just to 
the left of (H:). If you want to point to the Backup 
directory, then you would use \\ntserver\d-
drive\Backup. This is the equivalent of h:\Backup. 

 
 
Anywhere you must specify paths when setting up QC-PLC (including the 
settings paths), make sure you use UNC style paths. Remember that the service 
will need to get to the path and it won’t understand what your “M” drive is.  
 
NOTE: You can use local drive letters such as C:\ or D:\ since they are local to 
the PC and will not change. 
 
 
 
 
 
 

--- End of QC-PLC Manual --- 
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